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Introduction 
 
Since the mid-1980's, physics teachers have been taking their students to amusement parks in 
ever-increasing numbers. The purpose of such trips is to study the forces and accelerations that 
students experience on various rides and to apply science concepts to help explain their 
experiences. These concepts include Newton's laws, momentum, energy, centripetal force, 
projectile motion and free fall. This booklet discusses many of the issues and decisions relative 
to collecting data at an amusement park, including specific directions for data collection with 
Vernier equipment. While most references will be to collecting data on roller coasters, the 
discussion applies equally to other rides one encounters at an amusement park. 
 
Interpreting data gathered at the amusement park is a learned activity. Students need guidance in 
determining what to look for and how to make sense of the “wiggles and squiggles” on the 
graphs. This document doesn’t go into interpretation. However, the forthcoming second edition 
of the Handbook on Amusement Park Physics, available from AAPT in mid-2007, will discuss 
data interpretation and give several examples. http://www.aapt.org/Store/index.cfm 
 

 
Grizzly at Paramount's Great America in Santa Clara, CA. 

 
Physics Day at Paramount's Great America in Santa Clara, CA, is one of the larger physics days. 
The Gunn High School Physics Club has operated a booth at Physics Day since 1995. Students 
check out accelerometer units consisting of an interface (CBL™, CBL2™ or LabPro™), one or 
more accelerometers and a carrying case or DataVest™ (or a WDSS™) to take on a ride. When 
the ride is done, the students return to the Electronic Data Center to download their data and print 
their graphs. The data is then published through the Physics Day web site (www.physicsday.org) 
so they can download it back at their schools. Experience has shown several things. 

• Practice using the equipment before going to the park is essential for a successful 
physics day. 
• Plan ahead to make the most of your data collection experience. 
• Capturing data from an entire ride, while interesting, is not necessarily the best strategy. 
It is often better to focus on one section of the ride rather than the whole. 
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• Smoothing data often makes it easier to interpret. 
• Collecting three axes of data is often preferable to a single axis, although valuable 
insight can be gained with single-axis accelerometers. 
• Computers are more efficient for downloading and displaying data than calculators, 
although calculators can still be used effectively to load instructions into an interface. 

 

 
Invertigo at Paramount’s Great America 

 
The major sections of this document are as follows: 
Instrumentation 

While there is discussion of both traditional and electronic instrumentation for use at the 
amusement park, the primary focus of this document is on electronic sensors and the 
software that drives them. 

Data Collection 
This section discusses the steps one takes to gather electronic data. Several issues such as 
calibrating sensors and smoothing data are also discussed. 

Ride Suggestions 
This section discusses several aspects of amusement park rides. What are some of the key 
questions to have students focus on while they are riding? A must-read section if you are 
going to the amusement park for the first time. 

Appendices 
There are thirteen (13) appendices to this document, including specific step-by-step 
instructions for seven different combinations of sensors, interfaces and computer/ 
calculator/Palm. Two sections cover video capabilities built into Logger Pro beginning 
with version 3.1. A section on Creating A Ride Profile precedes a discussion of 
Accelerometers and Forces. A sample worksheet for students is included, too. A section 
of questions and answers completes this document. 

 
Although we may not have covered every possible question that you or your students will have, 
we have tried to hit most of the highlights. For questions about sensors, interfaces or software, 
contact Vernier Software & Technology by email at info@vernier.com or by phone at (888) 837-
6437. 
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We’d like to thank Paramount’s Great America in Santa Clara, California, and Six Flags Marine 
World in Vallejo, California, for the use of specific ride photographs in this document. 
 
Instrumentation 
 
Traditional Accelerometers 
Before the availability of electronic data-collection technology, students traditionally used hand-
carried devices called “accelerometers”. In general, these accelerometers measured the forces felt 
by a mass attached to a spring or rubber band, by the behavior of a mass on a string hanging 
from a protractor, or BB’s in a curved tube. The forces acting on the object with small mass is 
proportional to the force felt by our larger mass. We interpret the readings as “acceleration” or 
more properly, “force/mass” (force per unit mass). If the small mass feels a force that is double 
its weight, then the person holding the mass is also experiencing a force that is twice their 
weight. In this case, both the person and the mass experience forces that we can say are equal to 
2 g’s. While many people may call the reading of these devices “acceleration,” what they really 
measure is the ratio of force/mass. See Appendix 9 for further discussion of this topic. 

 
Traditional handheld devices are limited due to three factors: 

1. Students are occupied trying to watch the measuring instrument at the same time that they 
are being terrified by the ride experience. Accuracy is questionable. 
2. Readings have to be taken "on the fly" and then remembered until they can be written 
down at the end of the ride. 
3. Even under ideal conditions, the readings taken are single values and there is no effective 
way to record values over the entirety of a ride or even over a section. All of these effects 
lead to measurements that are at best estimates and are indeed guesses in many situations. 

 
Electronic Accelerometers 
For the reasons listed above, it is advantageous to employ electronic sensors. Students can collect 
data at short time intervals over part or over a whole ride using one of the Vernier accelerometers 
and an interface unit (CBL, CBL2 or LabPro) or WDSS. Compare getting values every 0.1 s or 
even every 0.02 s to trying to remember one reading. The primary focus of this manual is 
collecting amusement park data with electronic sensors. 
 

Horizontal Accelerometer

Typical handheld 
accelerometers that 
can be purchased or 
homemade
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Single-axis accelerometer on l axis accelerometer on right. 

 
uring a typical roller coaster ride, a student may be pushed up or 

le 

he next graph shows data collected on this ride. Note the steady 
 

 

eft;   3-

D
down, left or right, forward or back. A single axis accelerometer is 
capable of recording only one direction at a time. For some rides 
like free fall rides there is only one important axis. A good examp
is Drop Zone at Paramount’s Great America (shown on the right). A 
single axis works well on this ride because the ride is a one-
dimensional, free-fall drop. 
 
T
1-g reading (10 N/kg) while the riders are held at the top. Then the
0-g reading lasted for about three seconds while they fell. Finally 
the electromagnetic brakes bring the vehicle to a stop with a large,
but short-lived upward force that approached 4 g’s.  

 

At Top 
Braking 

Free 
Fall

Data from Drop Zone at Paramount’s Great America. 
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On other rides where the motion is more complex, choosing which axis to record is an important 
critical thinking step for students while planning their experiment. For example, many steel roller 
coasters have very small lateral forces due to the banking of the turns, so it may not be important 
to study that specific axis. 
 
Barometer 
Important data can be collected using a barometer. Barometric pressure changes follow the 
altitude changes during the course of a roller coaster ride, except pressure decreases as the 
altitude increases. The ratio is approximately 1 mm Hg equivalent pressure change for every 
11.1 meters of altitude change. Subtracting all pressure values from the highest one and 
multiplying by 11.1, you “invert” the graph and the result is a ride profile where height is given 
in meters relative to the lowest point on the ride. See Appendix 8. 
 
A major advantage of adding this ride profile is being able to more easily see where you were 
along the ride and to judge what the motion must have been that produced the corresponding 
force values. 

Corkscrew

Double Loop

 
Ride profile data collected for Top Gun, a roller coaster at 
Paramount's Great America. This ride features two vertical loops at 
the bottom of the first hill. Then the riders go through a corkscrew 
section before returning to the station. 
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WDSS 
The device shown to the right is a Wireless Dynamics 
Sensor System, WDSS. It contains a 3-axis 
accelerometer, an altimeter and an independent force 
sensor. The whole unit is powered by a rechargeable 
battery and communicates using Bluetooth radio. 
WDSS is by far the best choice for amusement park 
data collection with its combination of large data 
capacity, small size, rechargeable battery, and absence of connecting wires. 
 
In practice, the WDSS is programmed to collect data at some rate for a period of time, then set 
up for remote collection. When the students get to the ride, they press the start/stop button when 
the ride begins or they reach the desired place in the ride, then press the button again when the 
ride stops. Multiple runs can be collected before downloading the data. WDSS holds 
approximately 240,000 readings. 
 
See Appendix 1 for additional information and step-by-step instructions for carrying out the 
remote data collection with WDSS. 
 
Carrying Equipment 
Two systems work fairly well to carry the interface and sensors. The first is a customized case 
such as the one used to ship the original CBL. Cutting out the top of the case to reveal the 
display (original CBL only) and gain access to the buttons makes it very usable in the park. Plus 
the case protects the interface and the accelerometer while on the ride. Most parks require the 
case to be tethered to the rider, a good practice. The accelerometer is held in place with Velcro 
inside the case and on the bottom of the sensor. A barometer could also be carried in the case, or 
even several single-axis accelerometers.  
 

 
 
(Similar cases could be purchased from local sporting goods stores where they are designed to 
carry target pistols. Other options are available at kitchen supply stores, but they tend to lack the 
convenient carrying handle. Cutting foam to fit your components will complete the installation.) 
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A second option, shown on the next page, is Vernier’s DataVest. Placing the accelerometer in the 
pouch that is built into the DataVest holds the accelerometer in a constant orientation to the rider. 
 

QuickTime™ and a
TIFF (Uncompressed) decompressor

are needed to see this picture.

   
 
Getting the interface, a 3-axis accelerometer, and cables into the pouch on a DataVest could be 
challenging. One solution is to utilize the calculator cradle furnished with a LabPro and CBL 2 to 
hold the accelerometer and cables. Rubber bands will manage the cables nicely. In this diagram, 
the accelerometer has a Velcro fastener on the bottom and the calculator cradle has the matching 
piece of Velcro. 
 
The DataVest also has two smaller pockets on the inside. You can place a barometer inside one 
of these pockets and bring the cord into the interface pocket through the buttonholes in the large 
pocket. In practice, the LabPro or CBL2 doesn’t have to be removed from the pocket as access is 
furnished on the sides and bottom of the pocket with buttonholes. 

 

tatus 

WDSS can be safely carried in a DataVest if one obtains 
either a stack of corrugated cardboard equal in thickness to 
the height of the WDSS or a piece of fairly rigid foam that 
just fits inside the large pocket. Cut out a space to just fit the 
WDSS, making sure the start/stop button is available through 
the window in the large pocket and you can see the two s
LED’s. 
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Electronic Data Collection 
 
Equipment Needed 
One can collect data using a number of combinations of sensors, interfaces, computers/ 
calculators/Palm OS devices, etc. From experience, the process goes smoother and is more 
flexible if one uses a computer as the central device for programming your interface (LabPro or 
WDSS) and for downloading the data. However we provide specific instructions for a variety of 
situations as described below and in Appendices 1 through 5. 
 
Steps for Collecting Data  
When we use an interface and sensors to record data on amusement park rides, there is a general 
flow to the process: 

1. Set up data rate and duration for the collection process 
2. Load these instructions into the LabPro, CBL or WDSS unit 
3. Get on ride. Press [Start/Stop] button once just before the section you wish to measure 
4. Following the ride, download the data and print graphs. Save the data for further analysis 

or inclusion in projects. 
 
Specific Steps 
Several Appendix sections give specific directions for different combinations of interface 
software. 

• Appendix 1: Using WDSS. Materials: Wireless Dynamics Sensor System, Computer 
with Bluetooth wireless capability, Logger Pro 3.4.5 or newer. 
 

• Appendix 2: Logger Pro Remote Option. Materials: LabPro interface, Computer, 
Logger Pro 3.2 or newer 
 

• Appendix 3: Logger Pro Remote Option. Materials: LabPro interface, Computer, 
Logger Pro 2.2.1 
 

• Appendix 4: Using Calculator EasyData Program. Materials: TI-84Plus or TI-83Plus 
Silver Edition graphing calculator, LabPro, CBL2 or EasyLink™ interface, EasyData 
program. 
 

• Appendix 5: Using Calculator DataMate Program. Materials: LabPro or CBL 2 
interface, TI-83Plus, 84Plus, 86, 89, 92, or 92Plus graphing calculator, DataMate 
program. 
 

• Appendix 6: Using Calculator PHYSICS Program. Materials: Original CBL interface, 
TI-83Plus, 84Plus, 86, 89, 92, or 92Plus graphing calculator, PHYSICS program. 
 

• Appendix 7: Using Palm OS Device and DataPro Program. Materials: LabPro 
Interface, Palm OS Device, DataPro program. Covers remote data collection as well as 
attached. 
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Sampling Rate 
For any ride it is essential to plan data collection carefully. It is often best to concentrate on a 
single portion of a ride, such as a particular loop or dip of a roller coaster. Decide which part of 
the ride you wish to study, and estimate the length of time over which you will need to collect 
data. Measure the total time interval while watching others on the ride. Give yourself lead time to 
initiate data collection on your interface, too. The time between samples can then be calculated 
by dividing the desired time by the number of points you want to collect. Collect as many points 
as your calculator, Palm or computer can conveniently handle. 
 

Example: A particular portion of a ride lasts 20 seconds. If you collect 200 data points, 
the samples must be 20 s/200 = 0.1 second apart. If several movements happen in that 
time, an even shorter interval may be preferable and thus more samples should be 
collected. [As a rule of thumb, at Paramount’s Great America we usually collect at a rate 
of 20 samples per second. But in some cases we increase the rate to 50 samples per 
second for fairly short time intervals.] 

 
Orientation 
Plan how you will orient a single-axis accelerometer during the ride. Which axis do you want to 
record? Hold or fasten the accelerometer so the arrow is parallel to this axis. The direction of the 
arrow corresponds to positive acceleration. See page 11 for more ideas on orientation. 
 
Calibrating Sensors 
Calibration of sensors is usually not necessary. There may be some variation from unit to unit, 
but the default calibration is sufficiently accurate to give good readings at normal temperatures.  
 
Calibration of the accelerometer can be done, however, using gravity. Calibration is found 
under Experiment on the menu bar for Logger Pro. To calibrate the sensor, position the 
accelerometer with the arrow pointing down for the first calibration point. Define this as  
-9.8 N/kg or -1 g. Turn the accelerometer so the arrow points up and use the reading you get for 
the second calibration point. Define this as +9.8 N/kg or +1 g. The accelerometer will then read 0 
when held horizontally. Calibration must be done one axis at a time if you are using 3-axis 
accelerometers. 
 
If the arrow remains pointing upwards during a ride, the readings that are obtained will be  
+9.8 N/kg or +1 g except when going over a bump, through a dip or some other complex motion. 
Values go up or down when the rider goes upside down or goes through a banked turn. 
 
If you seek a net value, you will need to know what the orientation of the accelerometer is at that 
point. If the arrow points upward, the net value will be the reading minus 9.8 N/kg, or the 
reading minus 1 g. On the other hand, if you are upside down, the net value is the reading plus 
9.8 N/kg or the reading plus 1 g. The author recommends calibrating the sensors as described and 
then determining net values on a case-by-case basis depending on the nature of the individual 
ride. 
 

 -9- 



Zeroing Sensors 
If you wish to make sure the reading is indeed zero (0) when the arrow is held horizontally, you 
can zero the sensor. This function is found in the Experiment menu. Hold the sensor with the 
arrow horizontal, choose Zero Sensor from the menu, and follow the on-screen instructions. 
 
Be cautious. If you zero all three axes at once (assuming a 3-axis accelerometer), you will 
change the calibration points of the axis that’s oriented vertically at that moment. Read the dialog 
boxes carefully and zero only one axis at a time rather than all at once if you are using a 3-axis 
accelerometer. 
 
Vector Sum for 3-Axis Accelerometers 
On many roller coasters, good readings in all three axes can be inhibited by either the manner in 
which the student holds the sensors, or by the "toss and turn" nature of the ride. In such cases, we 
suggest looking at the vector sum of all values, and then compare the resulting values to the 
relative location along the ride. To get a vector sum, take the square root of the sum of the 
squares: 

asum = (ax
2 + ay

2 + az
2 )

 
 
Under Data, select New Calculated Column. In the dialog box, choose a logical name like 
“Vector Sum.” Then for the definition, use a combination of pull-down menus and typing to get 
a formula similar to the following: 
 

sqrt("Vertical"^2 + "Lateral"^2 + "Longitudinal"^2) 
or 

(“Vertical”^2+”Lateral”^2+”Longitudinal”^2)^0.5 
 

Note that you’ll be able to select an appropriate color for this plot under Options. You will be 
able to display this graph the same as you would the graph of any individual axis by clicking on 
the vertical axis label and choosing “Vector Sum” from the menu that appears. 
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Smoothing Data 
Smoothing of data is taking averages of every 
3, 5, 7, … points and plotting the resulting v
instead of the original values. The result of doing
this is to remove some of the "electronic jitters" 
that occur in the data due to digitizing analog 
data. It also helps to smooth out some of the 
vibrations that are inherent in most coasters. It is 
useful to be able to look at a smoother graph 
rather than one filled with lots of little spikes. 
The method used to smooth data depends on 
whether you are using calculators or computers. 

alues 
 

 
For Logger Pro 3.x, go to File then choose 
Settings for this file. You set the number of 
points to use while smoothing here. See screen 
shot on right where the smoothing has been set for every 5 data points. 
 
Under Data, select New Calculated Column. In the dialog box, choose a name like “Smooth 
Vertical” or similar. For Definition or Equation, start by choosing SmoothSG from the drop-
down functions menu. Then choose the appropriate quantity from the drop-down Variables 
menu. 
 
The graph below shows the same data in two different ways. The lower, teal trace is original data 
while the upper, red one is smoothed. Significant details stand out more when the data has been 
smoothed. Students should be aware, though, that smoothing will change the magnitude of 
peaks, especially sharp ones, and data values should be taken from unsmoothed data. 
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Pre-trip Suggestion 
 
Try remote data collection at school before going to the park. Make sure you and your students 
know how the equipment works and have some hands-on experience gathering, downloading and 
interpreting data before going to the park. Some suggestions: 

• Jump straight up and land on the ground in different ways (bend your knees different 
amounts to absorb more or less of the shock) 

• Jump down from a chair or low table; try to minimize the maximum value 
• Spin around in a circle holding the sensor with its measuring direction pointed radially; 

compare to spinning around with the sensor oriented tangentially 
• Swing your arm with the accelerometer acting like a pendulum 
• Swing your arm in a vertical circle at a constant rate 

 
The important thing is to practice so you will know what to do and how to think about the data 
you gather at the park. 
 
Ride Suggestions 
 
Directions on Ride 
When describing the directions of forces on an 
amusement park ride, it is convenient to have a 
common vocabulary. The diagram to the right 
defines the terms “vertical,” “lateral” and 
“longitudinal.” These designations are from the 
frame of reference of the rider. While it might 
be tempting to impose the earth frame of 
reference, when you are in the middle of a 
corkscrew section of a ride or partway through 
a vertical loop, it has little or no meaning to 
you! 
 
With a 3-axis accelerometer, students can gather data in all three axes - vertical, lateral and 
longitudinal. For many rides, the primary forces are vertical, but large lateral forces may be 
present, particularly on scrambler rides and wooden roller coasters. Being able to look at all three 
axes enables students to unravel their total experience. A key step in the interpretation of the data 
is identifying which axis is being recorded by which channel. To match the readings with the 
rider's position, one axis should be aligned with the rider's spine, a second should be directed 
side-to-side, and the third forward and back. 
 
Dips 
Most roller coasters feature a dip following the first major climb, as well as several others during 
the course of the ride. If you know the speed of the train at the top of the hill and the vertical 
distance to the bottom, the speed of the train at the bottom can be calculated using conservation 
of energy. Knowing the radius of the curve at the bottom, the acceleration due to circular motion 
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can be calculated using kinematics. 
 
The normal force to mass ratio (F/m) can be measured as the train descends, and the maximum 
value can be determined by tracing along the graph. Note that the total experience is due not only 
to the circular motion but also to the background effect of gravity. Basic physics shows that the 
force from the seat on the rider equals the weight (mg) plus the centripetal force (mv2/R). 

Fseat = mg + mv2

R
 

Compare the readings obtained with your electronic sensors and the values that you calculated 
from energy considerations. Compare the readings at the front of the train with those at the 
center or at the back of the train. Explain any differences. 
 
Vertical Loops 
Many roller coasters feature vertical loops. How does the F/m ratio at the bottom of the loop 
compare to the F/m ratio at the top of the loop? How does the value at the top compare to normal 
gravity, 9.8 N/kg = 1 g? What does the reading you get at the top mean? Is the loop circular in 
shape? If not, why isn’t it circular? 
 
Corners 
Wood roller coasters have cars riding on top of the rails. Many corners may be nearly horizontal. 
If the axis of the sensor is held level with the car and perpendicular to the direction of the 
motion, the lateral forces can be studied. Measure the speed of the ride and estimate the radius of 
curvature. A value for the centripetal acceleration can then be calculated using kinematics. 
Compare the calculated acceleration with the measured F/m ratio. What could lead to the two 
values being different? 
 
Barrels 
Some rides at amusement parks and carnivals feature a barrel in which the riders appear to be 
held to the inside surface by an outward force. In fact, there is no outward force. The inward 
normal force from the wall keeps the riders moving in a circular path. To take data in a barrel 
ride, first zero the accelerometer with the axis held horizontally. Collect data for the radial 
acceleration. Because this type of ride is rotating at a constant angular velocity, the physics is 
that of uniform circular motion. The acceleration is radially inward and should be equal to 
4π2R/T2. Calculate the acceleration from measurements of R and the period T for comparison to 
the acceleration measured while on the ride. The changes in this value while the ride is starting 
up and also while slowing down can be studied using the data. 
 
Starts And Stops 
Many rides feature large linear accelerations. If the direction is forward or back, the reference is 
to longitudinal acceleration, while if it is up or down, it is vertical. Rapid starts and stops are 
usually short lived. A data collection time period of 10–15 seconds is usually enough to capture 
the entire acceleration, allowing you to start the collection just before the ride begins or just 
before it enters the station and comes to a stop. Study the ride in advance to choose an 
appropriate data collection time and trigger point. Which is larger, the starting or the stopping 
acceleration? Why might one be larger than the other? 
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Scramblers 
Some parks rides are known as scramblers. In a scrambler, the rider’s seat rotates about a pivot 
point with a small radius while that point is carried around in a larger radius by the overall ride. 
If the axis of the sensor is held so it is directed to the side of the rider, it will record the lateral 
values throughout the ride. If the sensor is pointed forward or backward relative to the rider, it 
will record the longitudinal values. For these rides, zero the accelerometer while the arrow is 
held horizontally. How close are the radial values experienced on the scrambler to 1 g? 
 

 
Data from Triple Play at Paramount's Great America, a scrambler ride. This is the lateral 
acceleration in g's. 
 

Investigations at the Park 
 
Here are some useful questions that might be investigated with the use of electronic instruments: 
 
1. Expert riders such as members of American Coaster Enthusiasts (ACE) tell us that they can 

feel the difference in ride between the front right and front left seats of a roller coaster. They 
can also tell the difference between front, middle and back. Gather data that shows how 
much difference there is between different seats on the same train of the same ride. 

2. Compare the speeds, forces and degree of curvature at the bottom and top of a vertical loop. 
How do the forces compare to theory? Why don't passengers fall out at the top of the loop? 

3. Where do passengers experience the greatest force on a given ride? Why is the largest force 
at this point and not at another point on the same ride? 

4. We can record forces along the longitudinal, lateral and vertical axes. In terms of the total 
force felt for a given ride, which of these is the biggest contributor? As you compare rides at 
a park, which rides give the most lateral force? Which rides give the most longitudinal force? 
Which rides give the most vertical force? Why? 

5. Research along which axis people can best tolerate high force. How does this relate to the 
design of roller coasters and the forces experienced there? 

6. Develop a question or series of questions you would like to investigate. Design your 
methodology then carry it out, reporting your results. 
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Celebration Swings at Paramount’s Great America 

 
Extensions 
 
1. Carry an accelerometer while snow skiing or snowboarding. Make several turns while 

recording the lateral acceleration. A procedure similar to the one described could be 
employed to study the turning accelerations as the skier makes sharp and gradual turns. 

2. Have a skier, skateboarder or a bicyclist go over a vertical jump and record the acceleration 
in the vertical direction during the jump. Video analysis measurements could be used as a 
comparison to the interface measurements. 

3. Have a rider on a skateboard, ice skates or roller blades execute a series of turns while 
carrying an accelerometer and interface. Basic kinematics can be used to compare to the 
recorded values 

4. Other carnival and amusement park rides can be studied using techniques similar to the ones 
described above. Most have a preferred direction of acceleration that can be ascertained by 
studying the motion of the ride. 

5. Strap an accelerometer to a bungee jumper to record the forces during a jump. Typically, the 
jumper tumbles while in the air. As a result, better quality data can be obtained by recording 
the three orthogonal axes using three accelerometers or a 3-axis accelerometer. The vector 
sum of the three is the instantaneous magnitude of the force of the jumper. 

6. Use a Vernier barometer to measure air pressure during the motion of an elevator or roller 
coaster ride, and convert air pressure data to altitude. The conversion is approximately a 1-
mm Hg equivalent drop in pressure per 11.1 meters gain in altitude. 

 
Web Sites 
 
http://www.vernier.com  
http://www.physicsday.org (extensive links page and student ride activity pages) 
 
 
Whatever else you do, have fun with the technology. Plan to learn a little more each year. Not 
only will there be new rides, but your own ability to sift through the data and to make sense of it 
will improve with experience. 
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Appendix 1 – WDSS at the Amusement Park 
MATERIALS 

Wireless Dynamics Sensor System (WDSS) 
Computer that is Bluetooth enabled 

The following steps will guide you through configuring the WDSS with a computer to collect 
data so that you need to carry only the WDSS to the ride. After collecting data, reconnect the 
WDSS and data can then transferred to the computer for analysis. 
You will need to set the time between samples and/or the number of points collected for your 
particular ride. Adjust these values as you design your experiment. 
GENERAL PROCEDURE 

1. Connect WDSS to your computer. 
• Launch Logger Pro 
• Under Experiment, choose Connect Interface > Wireless > Scan for Wireless 

Devices 
2. Once the WDSS has been found and connected (follow onscreen menu), select Open. In 

the Experiment folder, choose Additional Physics > Amusement Park Physics > 
WDSS. 

3. Click on the WDSS icon that’s immediately above the data table. In the menu that drops 
down, make sure the boxes for the three Accelerometer directions and the Altimeter are 
checked and the box for Forces is unchecked. For each of the Accelerometer directions, 
use the drop-down Configure menu to set the units to N/kg. Click on [Close] when 
finished. 

4. Click on the “stopwatch” icon immediately left of the Collect 
button. In the window that appears, set your data rate and 
collection time. We recommend you set the collection time longer 
than the actual ride duration. Click on [Done] when finished. 

5. Under Experiment, choose Remote > Setup > WDSS: Click 
[OK] to complete the operation. The LED above the power switch 
should change from green to red, indicating that the WDSS has 
disconnected from the computer. The WDSS is now ready to 
collect data. Note that the WDSS can actually be powered off at 
this point, and when re-powered, it will still be in remote data 
collection mode. 

6. Proceed to the ride. Once on the ride, orient the WDSS as 
appropriate for your experiment. Collect data when you are ready 
by pressing the Start/Stop button. When the green LED just b
the accelerometer label is blinking, data is being collected by the WDSS. A steady green 
light means the unit is on, but not actively collecting data. 

elow 

7. At the end of the run, pressing Start/Stop will halt data collection. If you do not press the 
button at this time, WDSS will continue collecting data until the end of the collection 
time you set in step 4, when it will stop automatically. 

8. You can now move to another ride and repeat data collection, or you can repeat your run 
on the same ride. WDSS supports multiple data runs until its memory is completely full. 
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DOWNLOADING DATA 

9. Return to the computer that programmed the WDSS. Launch Logger Pro and reconnect. 
(Experiment > Connect Interface > Wireless > Scan for Wireless Devices)  

10. The window on the next page should appear. 

  
Click on Yes to retrieve your data, bringing up the next window. 
 

  
OK would be a good choice. Then the next window appears. 
 

 
Clicking on the box under Retrieve will begin the download process. If you collected data 
on more than one ride, the data can be collected for multiple “Runs” or one run at a 
time.* 
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11. Label the data columns with the appropriate axes (Vertical, Lateral, etc.) Analyze the 

data, change the graph that is displayed, print out the graphs, etc. Save the data with an 
appropriate name indicating the ride and the riders. 

 
 

 
 
12. The WDSS can be reset to collect fresh data by repeating step 5. 

 
* It is recommended that the user delete runs as they are retrieved to clear up memory space on 
the WDSS for future data runs. If you wish to return to the screen seen in Step 10 above, click on 
the WDSS icon just above the data table. In the menu that appears, click on [Manage Memory] 
to have access to downloading or deleting data runs.  
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Appendix 2 – Logger Pro 3.x Remote Option 
MATERIALS 

LabPro interface Low-g or 3-axis accelerometer 
Computer Serial or USB cable 
Barometer (optional) 

The following steps will guide you through configuring the LabPro interface with a computer to 
collect data so that you need to carry only the interface and sensor(s) without a computer. After 
collecting data, the interface is reconnected and data are then transferred to the computer for 
analysis. 
You will need to set the time between samples and/or the number of points collected for your 
particular ride. Adjust these values as you design your experiment. 
GENERAL PROCEDURE 

1. Connect LabPro to computer using either a serial cable or USB cable. Launch 
Logger Pro. 

2. Select then open the appropriate file below. All are available for download from 
http://www.vernier.com/cmat/datapark.html and are available with versions of 
Logger Pro software beginning with 3.3 in the Experiments folder. Open > Experiment 
> Additional Physics > Amusement Park Physics 
• amuse1 - Single axis accelerometer only 
• amuse3 - 3-axis accelerometer only 
• amuse1b - Single axis accelerometer plus barometer - use CH1, CH2(baro) 
• amuse3daccbaro - 3-axis accelerometer plus barometer - use CH1, CH2, CH3, 

CH4(baro) 
3. Connect the sensor(s) to LabPro. 
4. Check the sample rate and number of samples. 

a. Under Experiment, choose Data Collection... (or click on the stopwatch icon) 
b. Under Collection, set the total time for collection and the samples per second. 

5. Under Experiment, choose Remote > Remote Setup... > LabPro 1. Click OK to 
complete the operation. A yellow LED should be lighted on the LabPro indicating that it 
is ready to collect data. 

6. Disconnect the serial or USB cable and proceed to the ride. 
7. Orient the accelerometer as appropriate for your experiment. Collect data when you are 

ready by pressing the START/STOP button on the interface once*. At the end of data 
collection, the LabPro will beep and stop automatically. You do not need to press the 
START/STOP button to stop data collection unless the ride is surprisingly short. 

8. Launch Logger Pro and open the same file that was used to load the data into the LabPro. 
Re-connect the LabPro to the computer with the serial or USB cable. Follow instructions 
from the dialog boxes to download the data. It will fill the data table automatically.  

9. Save the data with an appropriate name indicating the ride and the riders. Label the data 
columns appropriately (Vertical, Lateral, etc.)  

10. The LabPro can be reset to collect fresh data by simply repeating step 5. 
 
* Notes: LabPro currently supports only one set of data collection at a time. It is important to 
press the START/STOP button just before you wish to begin collection. Pressing it too early may 
leave you with a set of meaningless data. Pressing the START/STOP button twice will result in 
data collection stopping prematurely. Press the button just once. 

 -19- 

http://www.vernier.com/cmat/datapark.html


Appendix 3 - Logger Pro 2.2.1 Remote Option 
MATERIALS 

LabPro interface Low-g or 3-axis accelerometer 
Computer Serial or USB cable 
Barometer (optional) 

The following steps will guide you through configuring the LabPro interface with a computer to 
collect data so that you need to carry only the interface and sensor(s) without a computer. After 
collecting data, the interface is reconnected and data are then transferred to the computer for 
analysis. 
You will need to set the time between samples and/or the number of points collected for your 
particular ride. Adjust these values as you design your experiment. 
GENERAL PROCEDURE 

1. Connect LabPro to computer using either a serial cable or USB cable. Launch 
Logger Pro 2.2.1. 

2. Select then open the appropriate file below. All are available for download from 
http://www.vernier.com/cmat/datapark.html. 
• AMUSE1.MBL - Single axis accelerometer only - use CH1 
• AMUSE3.MBL - 3-axis accelerometer only - use CH1, CH2, CH3 
• AMUSE1B.MBL - Single axis accelerometer plus barometer - use CH1, CH2(baro) 
• AMUSE3B.MBL - 3-axis accelerometer plus barometer - use CH1, CH2, CH3, 

CH4(baro) 
3. Connect the sensor(s) to LabPro. 
4. Check the sample rate and number of samples. 

a. Under Setup, choose Data Collection... 
b. Under Sampling set the total time for collection and the samples per second. 
c. Under Experiment, make sure Live Readouts is unchecked. If it is checked, move 

the mouse to it and let up on the mouse button. 
5. Under Remote choose Set Up LabPro... Click OK to complete the operation. A yellow 

LED should be lighted on the LabPro indicating that it is ready to collect data. 
6. Disconnect the serial or USB cable and proceed to the ride. 
7. Orient the sensor(s) as appropriate for your experiment. Collect data when you are ready 

by pressing the START/STOP button on the interface once*. At the end of data 
collection, the LabPro will beep and automatically stop. You do not need to press the 
START/STOP button to stop data collection. 

8. Launch Logger Pro and open the same file that was used to load the data into the LabPro. 
Re-connect the LabPro to the computer with the serial or USB cable. Follow instructions 
from the dialog box(es) to download the data. It will fill the data table automatically.  

9. Label the data columns with the appropriate axes (Vertical, Lateral, etc.) Analyze the 
data, change the graph that is displayed, print out the graphs, etc. Save the data with an 
appropriate name indicating the ride and the riders. 

10. The LabPro can be reset to collect fresh data by simply repeating step 5. 
 
* Notes: LabPro currently supports only one set of data collection at a time. It is important to 
press the START/STOP button just before you wish to begin collection. Pressing it too early may 
leave you with a set of meaningless data. Pressing the START/STOP button twice may result in 
data collection stopping prematurely. Press the button just once. 
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Appendix 4 - Using Calculator EasyData Program 
MATERIALS 

LabPro or CBL2 interface or EasyLink 
Low-g or 3-Axis accelerometer (Low-g accelerometer only with EasyLink) 
TI Graphing Calculator:  TI83 Plus or TI-84 Plus series 
EasyData program 
Barometer (optional) 

The following steps will guide you through configuring EasyData to collect data at the park. 
After collecting data, the calculator can be connected to a computer for downloading and saving 
the data. 
Memory: The memory space in graphing calculators is somewhat limited. It is used for both 
programs and data storage. With no programs, we were able to gather over 300 sets of data using 
a 3-Axis accelerometer and a barometer (4 sets of data plus time). To enhance data space, clear 
out programs. 
 
GENERAL PROCEDURE 

1. Interface: Connect the TI graphing calculator to a LabPro or CBL2 using the supplied 
link cable. EasyLink: Connect the EasyLink to the TI-84+ using the mini-USB port. 

2. Connect the accelerometer (and barometer if you are using it) to the interface or to the 
EasyLink. 

3. Launch EasyData, found under the [APPS] button. The sensors you have installed should 
show up on the screen. 

4. If you wish to change units for the barometer, press the button under Setup. Choose the 
Barometer. Then press the button under Units and choose the pressure unit you wish to 
use. 

5. Set up the calculator and interface for data collection. 
a. Press the button under Setup. Choose Time Graph. 
b. Examine the time settings. To change these, press the button under Edit. Enter the 

time between samples and the number of samples as requested. If you do not 
achieve the correct values you wish, press the button under Edit again and repeat. 

6. When you get on the ride, orient the accelerometer as appropriate for your experiment. 
Press the button under Start to initiate data collection. You may be asked if you wish to 
overwrite existing data, to which you should reply OK. A green LED on the LabPro or 
CBL2 will blink to indicate the interface collecting data. 

7. Examine individual graphs by pressing the button under Plots and choosing the plot you 
wish to study. Tracing is automatically turned on, so you can step across the graph noting 
important values by using the arrow keys. 

8. Note: If the data is not downloaded to a computer for safe storage, a second data 
collection will likely end up deleting your data. 

 
DOWNLOADING DATA 
The data from the calculator can be downloaded to a computer for storage and printing of the 
graphs using either Graphical Analysis or Logger Pro. The instructions depend on your version 
of the software. If the steps that follow (written for Logger Pro 3.x) don’t work for you, refer to 
the Help menu on your software. 
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1. Quit the EasyData program. You will be informed which lists contain the data you just 
collected. Remember which lists you need to download. 

2. Connect the calculator to the computer using a TI-Graph Link Cable or the USB-to-mini 
USB cable supplied with the TI-84 Plus. 

3. Launch Graphical Analysis or Logger Pro from Vernier. 
4. Click once in the first cell of the data table. Go to the button that looks like a calculator 

(Download from TI Device). In the dropdown menu, select the specific connection device 
you are using (either TI Connectivity Cable or USB Direct). If necessary, have Graphical 
Analysis or Logger Pro scan for devices. 

5. Follow the indicated steps in the dialog box, including selecting which lists of data to 
download. 

6. Label the columns of data you have in the computer program to complete this step, 
including appropriate units. Save the file with the ride name and the names of the riders. 

7. Disconnect the calculator. 
 
** You can also connect a LabPro or CBL2 directly to a TI-Graph Link USB Cable. This allows 
you to extract the data directly into the computer without using the calculator. The steps are 
essentially the same. 
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Appendix 5 - Using Calculator DataMate Program 
MATERIALS 

LabPro or CBL 2 interface Low-g or 3-axis accelerometer 
TI Graphing Calculator:  TI73, 83 Plus, 84 series, 86, 89, or 89 Plus 
DataMate program 
Barometer (optional) 

The following steps will guide you through configuring the LabPro or CBL 2 interface to collect 
data so that you need to carry only the interface and sensor(s) without the calculator. After 
collecting data, the calculator is reconnected and data are then transferred to the calculator for 
analysis. 
GENERAL PROCEDURE 

4. Connect the Vernier accelerometer to LabPro or CBL 2. CH1 if single axis, CH1, CH2, 
CH3 if 3-axis. The barometer goes into CH2 if used with single axis accelerometer, or 
CH4 if used with a 3-axis accelerometer on LabPro only. 

5. Link to TI graphing calculator with black link cable. Start DataMate program (under 
APPS for models with flash memory). 

6. To set up manually: 
a. Select SETUP from the main screen. 
b. Select CH1. 
c. Choose ACCELEROMETER from the SELECT SENSOR list. 
d. Select LOW G ACCEL (M/S2) from the ACCELEROMETER list. 

9. Repeat steps above for CH2 and CH3 if using a 3-Axis Accelerometer. 
10. If using a Barometer, select appropriate channel. Select BAROMETER from the 

SELECT SENSOR list. Choose "mm Hg" for the units. 
11. Set up the calculator and interface for remote data collection. 

a. Select MODE then TIME GRAPH from the SELECT MODE screen. 
b. Select CHANGE TIME SETTINGS from the TIME SETTINGS screen. 
c. Enter your time between samples in seconds. 
d. Enter your number of samples. 
e. Select ADVANCED from the TIME GRAPH SETTINGS screen. 
f. Select CHANGE TRIGGERING from the ADV. TIME GRAPH SETTINGS 

screen. 
g. Select MANUAL TRIGGER from the SELECT TRIGGERING screen. 
h. Select OK three times to return to the main screen. 

12. Select START from the main screen. A yellow LED on the LabPro or CBL 2 will light to 
indicate the interface is ready to collect data. 

13. Disconnect the black link cable from the interface. You do not need to carry the 
calculator during data collection. 

14. Orient the accelerometer as appropriate for your experiment. Collect data when you are 
ready by pressing the START/STOP button on the interface once*. 

15. Use the calculator to retrieve data from the interface: 
a. Reconnect the calculator to the interface using the black link cable. 
b. Start the DataMate program. After the opening title screen, the calculator will 

display a message showing that data collection is complete. 
c. Select TOOLS from the main screen. 
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d. Select RETRIEVE DATA from the TOOLS screen. Data will now be transferred 
from the interface to your calculator. 

16. Examine the graph of acceleration vs. time. 
a. Trace along the graph with the cursor keys to read out particular values. 
b. Press ENTER to return to the main screen. 

 
* Notes: LabPro currently supports only one set of data collection at a time. It is important to 
press the START/STOP button just before you wish to begin collection. Pressing it too early may 
leave you with a set of meaningless data. Pressing the START/STOP button twice may result in 
data collection stopping prematurely. Press the button just once. 
 
The data from the calculator can be downloaded to a computer for storage and printing of the 
graphs using either Graphical Analysis or Logger Pro. The instructions depend on your version 
of the software. If the steps that follow (written for Logger Pro 3.2) don’t work for you, refer to 
the Help menu on your software. 

8. Quit the DataMate program. You will be informed which lists contain the data you just 
collected. Remember which lists you need to download. 

9. Connect the calculator to the computer using a TI-Graph Link Cable**. 
10. Launch Graphical Analysis or Logger Pro from Vernier. 
11. Click once in the first cell of the data table. Go to File on the menu bar and select 

Download from TI. A dialog box will appear indicating the computer is expecting to 
receive data from a TI device. 

12. Follow the indicated steps in the dialog box, including selecting which lists of data to 
download. 

13. Label the columns of data you have in the computer program to complete this step, 
including appropriate units. Save the file with the ride name and the names of the riders. 

14. Disconnect the calculator. 
 
** You can also connect the LabPro or CBL2 directly to the TI-Graph Link Cable. This allows 
you to extract the data directly into the computer without using the calculator. The steps are 
essentially the same. 

 -24- 



 
Appendix 6 - Using Calculator PHYSICS Program 
MATERIALS 

TI-82, 83, 83 Plus,84 Plus, 89, 92, or 92 Plus, Voyager200 
PHYSICS program loaded in calculator 
Original CBL 
Low-g or 3-axis accelerometer  

The following steps will guide you through configuring the original CBL to collect acceleration 
data so that you need to carry only the interface and sensor. After collecting data, the calculator 
is reconnected and data are then transferred to the calculator for analysis. Note that the PHYSICS 
program does not support barometers. 
GENERAL PROCEDURE 

1. Connect the Vernier accelerometer to the original CBL. CH1 if single axis, CH1, CH2, 
CH3 if 3-axis. 

2. Turn on the interface and the calculator. Start the PHYSICS program and proceed to the 
MAIN MENU. 

3. Select SET UP PROBES from the MAIN MENU. 
a. Select ONE as the number of probes for a single axis accelerometer or THREE 

for 3-axis accelerometer. 
b. Select ACCELEROMETER from the SELECT PROBE menu for each of your 

channels. 
c. Select USE STORED from the CALIBRATION menu. 
d. Select LOW-G from the ACCELEROMETER menu. 

4. Set up the interface for manual triggering. This allows you to take data when the interface 
is not connected to the calculator. 

a. Select TRIGGERING from the MAIN MENU. 
b. Select MANUAL from the TRIGGERING menu. 

5. You can zero the accelerometer in the orientation you plan to collect data. 
a. Select ZERO PROBES from the MAIN MENU. 
b. Select CHANNEL 1 from the SELECT CHANNEL menu. 
c. Orient your accelerometer so the orientation is horizontal for the axis you are 

zeroing and wait for the reading on the screen to stabilize. 
d. Press [+] to accept the current value as being zero. 
e. Repeat for other channels if present. 

6. Set up the calculator and interface for data collection. 
a. Select COLLECT DATA from the MAIN MENU. 
b. Select TIME GRAPH from the DATA COLLECTION menu. 
c. Enter the time between samples in seconds and the number of samples. The 

maximum number of data points that the original CBL can accumulate is 512. 
d. Press ENTER, then select USE TIME SETUP to continue. If you want to change 

the sample time or sample number, select MODIFY SETUP instead. 
7. Press ENTER to set the CBL up for remote data collection. Disconnect the link cable 

from the interface. The interface will collect data when you press the TRIGGER button. 
You do not need to carry the calculator during data collection. 

8. Orient the sensor as appropriate for your experiment, and collect data when you are ready 
by pressing the TRIGGER key on the CBL unit. When data collection is finished, the 
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CBL display will show DONE. Only press TRIGGER once* to start data collection; the 
CBL will quit collecting when the time has expired. 

9. Retrieve the data from the interface. 
a. Reconnect the calculator to the interface using the black link cable. 
b. Return to the MAIN MENU. 
c. Select RETRIEVE DATA from the MAIN MENU. 
d. Confirm that the interface is through collecting data, then press ENTER. 

10. View your acceleration graph and analyze data as needed. 
a. Press ENTER to view your graph. 
b. Trace along the graph with the cursor keys to read out particular values. 

 
The data from the calculator can be downloaded to a computer for storage and printing of the 
graphs using either Graphical Analysis or Logger Pro. The instructions depend on your version 
of the software. If the steps that follow (written for Logger Pro 3.2) don’t work for you, refer to 
the Help menu on your software. 

1. Quit the PHYSICS program. You will be informed which lists contain the data you just 
collected. Time is in L1. Remember which lists you need to download. 

2. Connect the calculator to the computer using a TI-Graph Link Cable. 
3. Launch Logger Pro or Graphical Analysis from Vernier. 
4. Click once in the first cell of the data table. Go to File on the menu bar and select 

Download from TI. A dialog box will appear indicating the computer is expecting to 
receive data from a TI device. 

5. Follow the indicated steps in the dialog box, including selecting which lists of data to 
download. 

6. Label the columns of data you have in the computer program to complete this step, 
including appropriate units. Save the file with the ride name and the names of the riders. 

7. Disconnect the calculator. 
 
* Notes: CBL supports only one set of data collection at a time. It is important to press the 
TRIGGER button just before you wish to begin collection. Pressing it too early may leave you 
with a set of meaningless data. Pressing the TRIGGER button twice may result in data collection 
stopping prematurely. Press the button just once. 
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Appendix 7 - Using Palm OS device and DataPro Program 
MATERIALS 

Palm OS device with DataPro program loaded 
Low-g accelerometer or 3-axis accelerometer 
LabPro System 
Barometer (optional) 
Handheld-to-LabPro Cable 
Computer with Graphical Analysis or Logger Pro software 
TI-Graph Link (optional) 

Remote Collection 
The following steps will guide you through configuring the LabPro to collect data so that you 
need to carry only the interface and sensor. After collecting data, the LabPro is connected to the 
computer with a serial cable, USB cable or TI-Graph Link. Data are then transferred to the 
computer using Graphical Analysis or Logger Pro software for analysis. 
You will need to modify either the time between samples or the number of points collected for 
your particular circumstances. Adjust these values as you design your experiment. 
GENERAL PROCEDURE 

1. Connect the Vernier accelerometer to LabPro. CH1 if single axis, CH1, CH2, CH3 if 3-
axis. Barometer goes into CH2 if used with single axis, or CH4 if used with 3-axis. 

2. Connect the Palm OS device to the LabPro with the Handheld-to-LabPro cable. Note that 
you do not use the pouch that traditionally holds the Palm device to the LabPro. The 
accelerometer can be carried using a calculator cradle as shown on page 6. 

3. Start the DataPro program and proceed as follows once the program reaches the main 
screen. 

a. Tap on [Setup]. If the program has identified the sensor(s) you are using correctly, 
skip ahead. 

c. Tap on CH1: From the pop-up menu, tap on the specific Accelerometer you are 
using. For example, you might choose “ACCEL3D-X axis (m/s2)”. Tap on that 
option to set the sensor. 

b. Continue this process until you have selected all of the sensors you will be using. 
For the Barometer, you should choose “BARO(mmHg)”. 

c. Use the Calibrate and Zero buttons to calibrate and/or zero the sensors. 
4. Set up the interface for Remote operation. This allows you to take data when the interface 

is not connected to the Palm device. 
a. Tap on “Mode:” Choose “Remote Setup” by tapping on it.  
b. On the screen that pops up, you can set the seconds per sample and the number of 

samples. Make sure the total time you will be collecting data covers the portion of 
the ride you are studying. 

c. Tap [Setup] to transfer the instructions to the LabPro. The yellow “ready” light 
will light up, indicating the LabPro is ready to begin data collection. 

5. Following the instructions on the screen, you disconnect the LabPro from the Palm 
device and proceed to the ride. Press the [Start/Stop] button on the LabPro once to initiate 
data collection. The LabPro will stop collecting data after its programmed time. 

6. Return the LabPro to a computer to download the data you have collected. 
a. Launch either Graphical Analysis or Logger Pro. Either program can be used to 
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download the data from the LabPro. 
b. Connect the LabPro to the computer with either a serial or USB cable, or with a 

TI-Graph Link. 
c. The following steps assume a TI-Graph Link. 

i. Click on the icon with the mini-calculator on it (“Import from TI Device” 
appears when you hold the cursor over the icon). 

ii. On the dialog box that appears, you may need to choose the type of TI-
Graph Link you are using. You may also need to click the [Scan for 
Device] button. 

iii. Once the LabPro has been found, select the channels in which you 
recorded data plus time. Click [Okay] to download the data. 

d. The following steps assume a serial or USB cable. 
i. When you connect the LabPro, you should get a dialog that indicates 

“Remote data have been detected….” Click on [Yes] to retrieve this data. 
ii. If you have a generic file open, the data will go in as a separate data set. 

That is fine. 
e. Label the data by double-clicking at the top of the respective columns of data. 

Hint: The one that progressively and regularly increases is time. 
f. Save the data with a title that will be meaningful for future reference. For 

example, you might want to include the name of the ride plus names from your 
group. 

 
Attached Collection 
The Palm OS device can accompany the LabPro and accelerometers (and barometer) throughout 
the ride experience. With the exception of trying to tap a small [Start] button while the ride is 
moving, this is an excellent way to collect data. There are some advantages that will be pointed 
out as well as disadvantages. 

1. Connect the Palm OS device to the LabPro with the Handheld-to-LabPro cable. Note that 
you will use the pouch that traditionally holds the Palm device to the LabPro. The 
accelerometer could be mounted on the pouch if a piece of Velcro is sewn on the outside, 
or it can be mounted on a plastic card and carried in a pocket on the DataVest. 

2. Start the DataPro program and proceed as follows once the program reaches the main 
screen. 

a. Tap on [Setup]. If the program has correctly identified the sensor(s) you are using 
correctly, skip to step (4). 

b. Tap on CH1: From the pop-up menu, tap on the specific Accelerometer you are 
using. For example, you might choose “ACCEL3D-X axis (m/s2)”. Tap on that 
option to set the sensor. 

c. Continue this process until you have selected all of the sensors you will be using. 
For the Barometer, you should choose “BARO(mmHg)”. 

d. Tap on the Mode button and set it to “Time Graph”. 
e. Click on the Settings button and set the Seconds/Sample and Number of Samples 

to values you have previously determined. The total collection time will be shown 
so you can check to be sure you are collecting enough data. Tap [OK] when you 
have the setting you wish to use. 

f. Note: The more data you collect, the longer it will take to download. 
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g. Use the Calibrate and Zero buttons to calibrate and/or zero the sensors. Then press 
[OK] to accept the settings you will be using. 

3. While on the ride, tap on [Start] to begin data collection. The LabPro should beep and the 
green light should be lighted during collection. 

4. Following the data run, the data will be imported back into the Palm. This may take a 
while. Once it is there, you can save it to a file for future downloading and analysis. 

a. Tap the menu bar button for DataPro. Invoking the Save command will bring up 
a dialog box that indicates the name of the file that has been saved. This should be 
noted. (The file name includes the date and time of the save.) 

5. After saving, a fresh set of data can be gathered by tapping the [Start] button. This 
overwrites the data that had been previously collected. If you wish to keep that run and 
have two different runs to compare, tap [Store] which will put the current run into 
temporary memory. It will be called something like Run1. Then tap [Start] to collect a 
second run. Subsequent runs will be considered part of the whole file that you will be 
saving once you are finished. 

6. Launch Logger Pro or Graphical Analysis. Follow normal procedures for hot syncing the 
Palm OS device to the computer. The program can now open up the saved files for 
analysis and printing. 

 
Advantage for Palm OS device: Multiple runs can be gathered without having to return to a main 
computer for downloading. The memory size for Palm is much larger than for a TI graphing 
calculator. For example, one group could study the accelerations in the front right, then the front 
left of a ride, while another could study the front right and back right of the same ride. All this 
data could be stored on the Palm until hot synced to the computer. 
 
Note that you can use Store to temporarily save a run, then make another before saving for easily 
comparing two different seats on the same ride, for example. Saving then saves a file on the 
Palm device that will be transferred to the computer upon hot-syncing. 
 
Note: The maximum number of rows of data in Data Pro is 500 if you wish to display the data 
on the Palm device. 
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Appendix 8 – Video Analysis 
 
Beginning with version 3.2, Logger Pro supports video analysis. One marks the progress of an 
object from frame to frame on a video clip, sets the scale, and then obtains a graph of position or 
velocity vs. time. Calculations can be done on the data to yield acceleration (derivative of the 
velocity), kinetic energy or gravitational potential energy. 
 
Requirements for the video 

• The format of the video clip should be QuickTime (.mov) or AVI (.avi). 
• The camera must not pan or zoom during the scene to be analyzed. A tripod is definitely 

recommended. 
• The camera should be as flat-on to the motion as possible to avoid errors introduced due 

to perspective. The motion should be confined to a plane. 
• Some object within the video frame should be of known size in order to set an accurate 

scale. Pacing off the length of a roller coaster car is one way to accomplish this task. 
 

 
Boomerang at Six Flags Marine World in Vallejo, CA. 

 
Obtaining video clip 
While there are many ways to obtain digital video that can be imported into Logger Pro, three 
will be outlined. A wide variety of specific computer programs can be used to accomplish this 
task. In all cases, if you have control of the shutter speed, it is advantageous to make it as fast as 
possible to obtain the sharpest images for analysis. 
 

1. Digital Still Camera 
Use the movie function on a digital still camera to capture the video clip you want. This 
can then be imported into your computer and then imported into Logger Pro. Formats 
vary from brand to brand and model to model. Save the file in .mov or .avi format. 
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2. Digital Video – Macintosh 
Footage taken with a digital camcorder can be imported into iMovie or another video 
editing program on a Macintosh. After selecting and editing the clip you wish to study, it 
can then be exported to QuickTime (.mov) and then imported into Logger Pro. 

3. Digital Video – PC 
Footage taken with a digital camcorder can be imported into a video editing program on a 
PC. After selecting the clip you wish to study, it should then be exported to .avi format 
and then imported into Logger Pro. 

 
Basic Steps 

3 2 1 

6

5

4

 
0. Open the movie using the Insert menu and choosing Movie. Once the movie has been 

inserted, go to Page and choose Auto Arrange. 
1. Click this button to initiate Video Analysis. The buttons on the right side of the video clip 

will appear now as will the data table and graph. 
2. Click this button to Play the video. Get close to the beginning of the action you wish to 

analyze then click the square button to Stop. 
3. Use these buttons to step forward or backward to zero in on the beginning frame. 
4. Click this button to begin marking points on the video. Move your cursor to a point such 

as the front of the train and click the mouse. A spot will be marked on the video and it 
automatically advances to the next frame. When finished, click button #4 to stop marking 
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points. 
5. Click this button to set up the scale. You will drag a line from one end of your standard 

length to the other. In the diagram above, the length of one car was paced off at 
approximately 3 meters. After dragging the line, you will be asked to enter the length that 
it represents. 

6. This button allows you to set the origin on the screen. For example, you could choose the 
first point you marked as 0,0 if you wish. 

 
Once you’ve marked the video and set the scale, graphs of X-position, Y-position, X-velocity 
and Y-velocity can be plotted and studied. To find the speed, calculate as follows: 

speed = ((X-velocity)2 + (Y-velocity)2)1/2

 
Some Questions to Investigate 

1. What is the maximum acceleration of the train? 
2. How does the speed of a train change as it goes through a series of bumps and dips. 
3. How does the speed of the train change as it goes through a vertical loop? 
4. How does the speed at the front of a train as it goes through a vertical loop compare to 

the speed at the back of the train? 
5. Is there a place on the train that behaves the same way that a point object going through 

the same ride would in terms of energy or motion? 
6. How much energy does the train lose going through a section of the ride? 

 
The graph above came from the Boomerang video and an analysis of the front car. Energy was 
calculated based on a mass of 500 kg. Some of the irregularity is due to the difficulty in finding 
the specific point to mark in each frame. Notable is the drop-off in total energy as the train goes 
through the vertical loop. Part of this is due to “dragging” the back part of the train up the side of 
the loop, while some of it is due to frictional losses. 
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Appendix 9 – Video Syncing 
 
Starting with Logger Pro 3.1, users have been able to import objects such as photographs and 
movies. Application of this ability can yield powerful results at the amusement park. 
 
Briefly, probes are used to gather data while a video camera is used to record the actions of the 
collection process. The movie is converted into QuickTime or AVI format and imported into the 
same page as the data. A significant point in the data is identified and the time is determined 
using the Examine feature under Analyze in Logger Pro. The same point in the video is 
determined and synchronized to that time. Afterwards, the video can be replayed while the data 
that was gathered is also played. 
 
In the experiment files, you will find several examples that have already been done for you. 
Under File, choose Open. Navigate to Experiments, then Sample Movies, then Drop Zone or 
Revolution or Vortex. Inside each folder you will find a .cmbl file that can be opened. 

 
This is the page as it opens for Revolution.cmbl. The video on the left was constructed by taking 
several different shots of the ride and piecing them together with simple video editing. The 
graphs don’t show data, yet, as it has been hidden. The Replay dialog box under Analyze has 
been activated, enabling the user to replay the video with the data displayed. Playback may not 
be completely synchronized, though, as the number of data points is fairly large and some slower 
computers will not be able to keep up with the demands of the video and the graphing. 
 
The resulting data is shown on the next page. Several interesting questions arise when one 
examines it closely.  
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The “g-factors” above are the vertical normal force per unit mass expressed in a form where  
1.0 equals 9.8 N/kg. The large negative values at about 55, 68 and 80 seconds occurred when the 
ride was completely upside down but moving slowly. The large positive forces came when the 
rider was passing through the lowest point of the pendulum motion. 
 
How to Make Your Own File 
 
Collect Data 

Follow the instructions in one of the appendices to collect data on the ride you are 
studying. Be sure to save the data once it has been downloaded into the computer. 
 

Take Video 
Use a digital video camera or the movie capability on a digital still camera to record the 
ride in question. Import the video into a computer and produce an AVI or QuickTime 
video. If the ride is shot from different angles, these can be edited together into a 
continuous sequence from beginning to end. Be sure to get the entire ride and don’t skip 
or duplicate any portions of the ride. Get the finished video and the data onto the same 
computer. 
 

Import Video 
1. Open the Logger Pro file. Resize the graph(s) to leave space to place the video. The data 

table can be removed from the screen or minimized in size. 

 -34- 



2. Under Insert choose Movie... Navigate to your video and choose it. It will appear on the 
Logger Pro page. Under Page, choose Auto Arrange. 

3. Note: Videos that have pans or zooms can be used for this activity, however they cannot 
be used for video analysis. 

 
Sychronize Video 

1. In your graph, determine an important point such as the lowest height or the highest 
acceleration. This is where the Altitude vs. Time graph is particularly helpful.  

2. Choose Examine under Analyze. Move the cursor and the resulting vertical line to the 
point in the graph you’ve previously identified. Note the time in the dialog box that 
appears. 

 
 
 
 
 Scrub Bar Sync ButtonStep Back/Ahead

3. Use the scrub bar to move the video to the point you’ve identified. Use the step forward 
or step backward buttons to zero in on the frame you seek. 

4. Click the Sync button. In the dialog box that appears, type in the time from your earlier 
work. Click [OK] to synchronize the two. Save the modified file at this point. A unique 
name should be given to this file. 

 
Play Back 

1. Choose Replay from the Analyze menu. The Replay dialog box will appear. 

 
 

2. In the dialog box you can simply click [Start] to replay the video and data from the 
beginning. With the video inactive, you can click [Hide Data] to present a blank graph 
upon opening the file. The slider can be used to show the video and data at either reduced 
or increased speed. 

 
Notes 

1. The synchronizing of video and data can take place well after you actually visit the park. 
2. If you take less data and employ smoothing, you will get a file that places fewer demands 

on the computer’s CPU.  
3. If you select Examine under Analyze, moving the cursor along the graph will also move 

the video forward or backward in step with the cursor position. 
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Appendix 10 – Creating a Ride Profile 
 
If you collect pressure data with a barometer, you will get a resulting graph that resembles the 
shape of the ride, but upside down. As the altitude increases, the pressure decreases. 
 
To get a ride profile, subtract all pressure readings from the highest pressure reading (often at the 
beginning of the ride). Then multiply the pressure difference by the ratio between height and 
pressure, 11.1 m/mm Hg. The formula will look like this: 

11.1*(max(“Pressure”)-“Pressure”) 
 
Step-by step for Logger Pro 3.x: 

1. Under Data, select New Calculated Column… 
2. Type “Altitude” or “Height” for the name. “Alt” or “Ht” might be used for the Short 

Name. Use “m” or “meters” for the unit. 
3. Equation: 

a. Type in “11.1*(“. 
b. Then use the Functions drop-down menu to get to statistics and then to max. 
c. Within the parentheses that are provided, use the Variables drop-down menu to 

choose Pressure. 
d. Add a “-“ outside the parentheses and go back to Variables again for Pressure. 
e. Finally, add one more parenthesis to close the equation. 

4. Choose the color for this plot under Options. 
5. If you wish to smooth the data for a nicer plot, start the same way, but before typing in 

the equation, go to Functions and choose SmoothSG. Everything in steps (a) to (e) will 
go inside the parentheses that are provided. The final result will be: 

SmoothSG(11.1*(max(“Pressure”)-“Pressure”)) 
 
The procedure is essentially the same for Logger Pro 2.2.1: 

1. Examine the pressure data either perusing the data table or using the Examine function 
(under Analyze) on the graph. Determine the largest pressure value. You will need this 
number. We’ll use 762.0 as the maximum pressure in the example that follows. 

2. Under Data, select New Column… then Formula… 
3. Choose an appropriate name “Altitude”, short name “Alt” and units “m or meters”. 
4. Click Definition. Under Equation: 
5. Type “11.1*(762.0-“ 
6. Under Variables, choose Pressure and add close parenthesis to complete the equation. 

The final result will be: 
11.1*(762.0-“Pressure”) 

7. If you wish to smooth the data for a nicer plot, Under Functions, choose Smooth() 
8. Inside the parentheses, type “11.1*(762.0-“ 
9. Then under Variables, choose Pressure plus close parenthesis to complete the equation. 

The final result will be: 
Smooth(11.1*(762.0-“Pressure”)) 

 
The procedure for Graphical Analysis depends on which version you are using. If you have 
difficulties, use the Help menu. 
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The graphs below will demonstrate both the pressure profile and the final ride profile. The 
altitude values have been smoothed. 

 
Pressure data from Demon at Paramount’s Great America 

 

 
Ride profile for Demon at Paramount’s Great America. Smoothing 
has been done on the data. The maximum altitude gradually 
decreases from the top of the lift hill through the end of the ride. 

 
UNITS: 
If you use different units for pressure, the conversion factor will be different. Here 
are several combinations: 

11.1 m/mm Hg 83.3 m/kPa  8436 m/atm 
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Appendix 11 - Accelerometers and Forces 
 
Accelerometers work by detecting forces. We look at the force acting on a small mass, divide it 
by the object’s mass, and calculate the force per unit mass. The ratio, which ends up in units of 
N/kg, is the same regardless of the amount of mass. These units are conveniently equivalent to 
acceleration units (m/s2), and thus the sensor has the ability to make direct measurements of 
acceleration for objects that are moving linearly. 
 
At the amusement park the predominant use of accelerometers is to indicate sizes and directions 
of forces experienced by riders. The origins of force, combinations of gravity and the actions of 
the rides, leads to forces that vary in size and direction throughout a ride experience. The 
electronic accelerometer is well suited for recording these forces. 
 
Visualize the accelerometer having a small mass unit that is held in place with a spring element. 
This is shown in the diagram below. 

mg

Normal�
Force - FN

accelerometer

sensor mass

A.  Forces on the sensor 
mass when it is not 
accelerating vertically.

F  = mg = 1 gN

mg
B.  Forces on the sensor 
mass when it accelerates 
vertically at 4.9 m/s .

F  = 1.5 mg = 1.5 gN

a = 4.9 m/s2

2

spring unit

When the sensor is not accelerating in a vertical direction (A), the spring element must exert a 
force upward equal to the weight of the mass, mg. A voltage is sent to the interface that we 
interpret as either 9.8 N/kg or 1 g. But if the sensor is accelerated upwards at 4.9 m/s2 (B), half 
the normal free-fall acceleration of gravity, the spring element must exert a larger force to 
accelerate the mass unit. The new force is 1.5 mg, or we could say that it is 14.7 N/kg or 1.5 g’s. 
In this way, the sensor is constantly monitoring the upward force exerted on the mass unit, and 
by extension, the upward force exerted on us. 
 
If we have the accelerometer oriented horizontally, the situation is diagrammed as shown on the 
next page. If there is no horizontal acceleration (C), the spring unit does not have to exert any 
force on the mass. The voltage sent to the interface would be interpreted as 0 N/kg or 0 g’s. 
However, if the sensor is accelerated at 4.9 m/s2 (D), the spring unit must exert a force equal to 
0.5 mg, and the voltage is interpreted as 4.9 N/kg or 0.5 g. 
 
It is important to note that whether the accelerometer is oriented vertically or horizontally, the 
force we are talking about is normal to the support. Although it’s a mouthful, we label the 
readings “Normal Force Per Unit Mass”, although we may shortcut this to simply “F/m”.  
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Normal�
Force - FN

C.  Force on the sensor 
mass when it is not 
accelerating horizontally.

F  = 0N

D.  Force on the sensor 
mass when it accelerates 
horizontally at 4.9 m/s .

F  = 0.5 mg = 0.5 gN

a = 4.9 m/s2

2
 

 
Units: Accelerometers are usually calibrated in units of m/s2. This is the same as N/kg and we 
infer that we are measuring normal force per unit mass even though the units say acceleration. 
9.8 m/s2 is the same as 9.8 N/kg, which could also be interpreted as 1 g, while 19.6 m/s2 or 19.6 
N/kg would be 2 g’s, etc. We recommend converting the units to N/kg or g’s to emphasize the 
nature of the readings. 
 
Axes: In practice, we analyze different axes separately. We discuss the forces in the 
forward/reverse (longitudinal), side-to-side (lateral), or up and down (vertical) directions. 
Breaking the forces up into the three major axes relative to our bodies and our motion helps us to 
explain the different forces we are experiencing and what led to those forces.  
 
If we are standing still or moving along a level track at a constant speed, there is one unit of 
force from gravity pulling us downward. The ground or seat exerts an opposing 1-g force upward 
on us to counteract this downward force. We feel this force constantly in our daily lives, and 
almost forget that it’s there. Elevators that are rising or descending at a constant speed also exert 
a constant 1-g upward force on us. 
 
The accelerometer measures the combined effects of both gravity and any actions of the ride we 
are on at the time. On a typical roller coaster, there is a dip at the bottom of the lift hill. As the 
riders pass through the bottom of the dip, they feel a very large upward force from the seat. This 
force is partly due to counteracting gravity and partly due to changing our motion into the curved 
path, which requires a net force towards the center, which is up at that point. So the force here is 
typically several times that of normal gravity. 
 
When the riders go over the top of a bump with some speed, they feel lighter than normal, almost 
as if they were lifted out of the seat. Again this is due to the reaction to gravity and the effect of 
the ride's motion. The center of the curve is below the riders so part of the gravitational force is 
used to pull them down towards the center, leaving less of their weight that must be supported by 
the seat. The force recorded here will be less than 1 g. 
 
If the riders go over a bump with sufficient speed, they may feel the car being moving out from 
beneath them, and they are pulled down by the restraint system. This is called "negative g's". The 
car is held on the track by wheels that ride below the track, while the shoulder harness pulls the 
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rider down. 
 
When riders go through a vertical loop, their force reading varies throughout the loop for several 
reasons. For one, the angle relative to gravity changes throughout the loop. The speed also 
changes due to climbing up the side of the loop then rolling down the other side. Finally, the 
degree of curvature in the loop changes. To understand the force readings throughout the loop 
one must understand how all of these factors are playing out. For example, on the side of the 
loop, whether rising or descending (A or C below), gravity acts along the longitudinal axis of the 
rider but not along the vertical axis. At the top of the loop (B), gravity acts to help hold the rider 
in the circular path, acting in a centripetal manner. The total force needed to go in the circular 
path, mv2/R, is partially supplied by gravity so the seat force towards the center of curvature at 

that moment is 
mv2

R
− mg

. If designers have calculated correctly, the seat will supply a force on 
the riders, holding them in their seat throughout the ride.  
 

 
 
As this discussion shows, the combination of gravity and the ride forces is complex. This is one 
of the fascinating aspects of amusement parks - trying to unravel the complexity presented by the 
twists and turns of the rides. 
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Appendix 12 – Sample Worksheet for Electronic Data Collection 
LabPro/CBL2 on a Roller Coaster 

 
Before you ride 

• The name of the ride you went on is:   
• Make a sketch of the ride profile on the back of this page. Mark the approximate position 

of a passenger every 10 seconds on your sketch. (This can be worked out either before or 
after riding.) 

• In the space below, describe your data collection strategy for this ride. Will you collect 
data for the entire ride, or concentrate on a specific portion? Which portion? How long 
does it take to go through the ride or that part of the ride, and how many data points 
would you like to acquire? Which axis or axes of acceleration will you focus on in your 
analysis? 

 
 
 
 
 
 
 
 
While you ride 

Secure the accelerometer in a fixed orientation relative to your body. The three axes are 
straight ahead (longitudinal), directly to the side (lateral) and/or straight up and down 
(vertical). If an axis is not used, don't circle it. 
 

Accelerometer X (#1):    longitudinal  -  lateral  -  vertical   (circle one) 

Accelerometer Y (#2):    longitudinal  -  lateral  -  vertical   (circle one) 

Accelerometer Z (#3):    longitudinal  -  lateral  -  vertical   (circle one) 

 
When you reach the place on the ride where you want to begin collecting data, press 
[Start/Stop] on the CBL2 or LabPro. 

 
After you ride 

Download the data. If possible, print the graphs of your normal force per unit mass vs. time 
so you can do onsite analysis. Save the data with your names and the name of the ride for 
further analysis. 
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Questions:
Use a separate page to answer the questions that follow. Use the ride profile to determine 
where you were on the ride for each of these portions. Also note any unusual forces 
encountered. 

 
1. Describe the graph(s) during the initial seconds you recorded. Compare the shape of the 

graph(s) to your movement during that portion of the ride. 
 

2. For each of your axes, where were the readings the greatest? What were the readings 
there? Explain why the readings were the greatest at those points. 
 

3. For each of your axes, where were the readings the least? What were the readings there? 
Explain why the readings were the least at those points. 
 

4. Are the places where the sensors recorded the largest values the same places you felt the 
largest forces? Why or why not? 

 
Ride Profile: 

• In this area, sketch the shape of the ride if it were stretched out linearly. Sketch loops as 
loops. Make other notations that will help you to decode your data later on. 

• Indicate on your ride profile the approximate location of a passenger every 10 seconds. 
This will enable you to match up your accelerometer data with your location on the ride. 

 
Example: A simple roller coaster for toddlers that makes a single loop around a closed track. 

0                     10s                                 30                         40                        50

Blue Streak 

start end
climb

first dip

20
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Appendix 13: Some Questions and Answers about Amusement Park 
Physics 
 
Q  In short, what is the process for gathering data on an amusement park ride? 
 
A  1) Set up data rate and duration for the collection process. 2) Load these instructions into the 
LabPro, CBL2 or WDSS unit, setting it for remote data collection. 3) Get on ride. Press 
[Start/Stop] button once just before the section of the ride you wish to measure. 4) Download the 
data and print graphs. (Be sure to save the data for further analysis.) 
 
 
Q  Can I use a calculator or must I use a computer? 
 
A  A calculator can be used to program your interface. The steps are given in Appendix 3 and 4. 
A calculator can also be used to download the data. However, the memory in most graphing 
calculators is very limited (20 Kb) so only a short data run can be imported into the calculator. 
 
To facilitate downloading more data, all programs that aren’t needed should be deleted. Trials 
should be run at school before going to the park to be sure the data downloads successfully. This 
avoids frustration at the park when things don’t work as you believe they should. 
 
The author has had good luck using the calculator to program the interface, but using a computer 
with TI-Graph Link to download the data. You can use either Graphical Analysis or Logger Pro 
to download the data. 
 
 
Q  I have an original CBL and want to work with a TI-83 calculator while I’m at the park. Do 
you have any tips? 
 
A  As noted in Appendix 4, you can use the PHYSICS program suite to program an original 
CBL and set it up for remote data collection. On the CBL you will press the [TRIGGER] button 
to initiate data collection. 
 
The TI-83 memory allows only a limited quantity of data points you can gather. Plan to use this 
system to study a section of a ride rather than the entire experience. You can also study repeating 
rides such as scramblers well with a limited number of data points. 
 
CBL has limited discrimination in the data it collects. Plan to smooth the data once you get it 
collected. This will give more meaningful graphs for your interpretation. Consider using one 
calculator per ride or portion of ride. Then take the data back to the classroom for downloading 
and plotting on the computer. 
 
Finally, download the latest version of the PHYSICS program from the Vernier web site 
(www.vernier.com) so that it will work as well as possible. 
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Q  Is there a central source of information on amusement park rides giving data and force 
values? 
 
A  Most parks and ride manufacturers tend to guard this information fairly closely. Some online 
sites give data but it should be advisory rather than exact.  
 
 
Q  Does an accelerometer really measure acceleration? Why do you keep saying it measures 
force? 
 
A  An accelerometer properly measures “normal force per unit mass”. This term has two parts. 
The first is that it measures forces normal to the accelerometer unit. If one is looking in a vertical 
direction, the sensor indicates the normal force pushing up on it. The second part is that the units 
are properly Force/Mass, N/kg. The combination reduces to m/s2, acceleration units, but the 
sensor is properly a force measuring device. 
 
 
Q  Can I use a Palm OS device at the amusement park? 
 
A  Yes. Appendix 5 will give you step-by-step instructions for using a Palm OS device with a 
LabPro. You will need DataPro software loaded in the Palm device. If you work in Remote 
mode, you will also need a computer to download the data from the LabPro. 
 
 
Q  Are there any issues with DataVest when collecting data at an amusement park? 
 
A  Two issues arise with DataVest. The first is orientation of the accelerometer. If you are using 
the cradle scheme described on page 6, the LabPro will be tilted to an angle depending on the 
person. Thus the vertical axis accelerometer may not be completely aligned with the spine. One 
solution would be to remove the accelerometer from the LabPro and mount it so it will always be 
vertical, independent of who is wearing the vest. One possible location is inside the strap that 
goes from front to back or on top of the shoulder. 
 
The second issue is that with the accelerometer near the rider’s shoulders, we are actually 
recording what happens to the rider’s body. As the car turns, the body reacts a short time later. 
The body may move back and forth a lot more than the ride itself. A nice study would be to 
compare the readings with an external case such as on page 6 and those using a DataVest on the 
same ride. 
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Q  What is the most common mistake that students make when collecting data? 
 
A  The most common mistake is to press the [Start/Stop] button more than once. As the name 
implies, this button will initiate data collection but it will also stop it. Pressing the button once 
will begin data collection that will continue until the end of the time that has been previously 
programmed. 
 
 
Q  Are there any advantages for using LabPro over using CBL2? 
 
A  Yes. (1) You can connect the LabPro to computers or Palm OS devices in addition to 
calculators. This makes using it more flexible. 
 
(2) You can connect four (4) analog devices to LabPro vs. three (3) in CBL2. This enables you to 
record all three acceleration axes plus barometric pressure. 
 
(3) The A-D converter, the device that converts the sensor readings into digital information, in 
the LabPro has 12 bits rather than 10. The extra two bits means that it is four times (4X) more 
sensitive to changes than CBL2. This is especially important when reading pressures and doing 
the ride profile. However, with smoothing, you can get quite presentable graphs from CBL2. 
 
 
Q  Are there any advantages for using WDSS over using other Vernier products? 
 
A  Yes. (1) The small package size means you can carry it in a DataVest, a fanny pack, or even 
in your hand (if it’s tethered so you can’t accidentally drop it). The small size and weight are 
distinct advantages of WDSS. 
 
(2) You can collect multiple runs on a WDSS versus a single run on a LabPro or CBL2. This 
allows one to pre-program the WDSS then use it on multiple rides before needing to download 
the data. In fact, the WDSS will hold up to 240,000 data points. 
 
(3) The data runs on WDSS can be longer than LabPro, enabling you to step up the data rate 
even higher and still capture a whole ride experience while seeing more detail. Note: we 
recommend you set a collection time longer than the longest time you expect to capture, then use 
the Start/Stop button to turn data collection off at the end of the ride. 
 
(4) The rechargeable battery means your ongoing expense at the park will be less than with 
LabPro or CBL2 unless you were to equip them with rechargeable batteries. 
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Q  What kinds of projects can students do in conjunction with going to an amusement park and 
carrying out data collection? 
 
A  Students get the most out of their experience when they turn the information they gather into 
a new product, especially when they are responsible for presenting their information to an 
audience. The graphs in Logger Pro or Graphical Analysis can be copied and inserted into a 
wide variety of programs ranging from word processors to video production. Data tables can be 
exported as data files which can then be imported into a variety of analysis programs, too. Some 
possible products: 
 

• Presentation to class analyzing a portion of a ride 
• Presentation to a younger class explaining how science applies at the park 
• Presentation comparing similar features on several different rides 
• See the Investigations or the Extensions on pages 13-14 

 
Presentations can be in the form of prepared overhead slides, Powerpoint or similar presentation 
program, videos either from videotape or from an edited final video, or in Logger Pro 3.x, 
students can use the pages feature to produce an effective and stunning electronic presentation. 
 
 
Q  Can I simply integrate the acceleration values (a function provided in Logger Pro) to obtain a 
new graph of velocity vs. time? 
 
A  The “acceleration” values we obtain while on a roller coaster are the result of combining 
gravity and ride forces. Riders are typically not traveling in straight lines, but at various angles 
including upside down. Integrating acceleration in most cases doesn’t yield anything useful. 
 
However, if the ride goes in a straight line (free fall ride where the rider is simply dropped, 
launching of a catapult ride, stopping of a coaster if it’s in a straight, level section, etc.) then 
integrating the recorded acceleration will yield a “Change in Velocity” graph. The steps to 
accomplish this in Logger Pro 3.2 are outlined here: 
 

1. Highlight the section of your graph you wish to study. Notice that the corresponding lines 
in the data table have been highlighted or selected. 

2. Now click on the data table to select it. Under Edit, select Copy. 
3. Under Data, select New Data Set. Click in the first cell of the new columns that are 

created in the data table. Under Edit, choose Paste. This will put the selected data into a 
new data set that can be graphed separately from the original data. 

4. Under Data, select New Calculated Column… Give the column a name like “Area 
Under Acceleration Graph” or “Change in Velocity.” Units would be m/s if you recorded 
acceleration in m/s2.  

5. For Equation: Under Function, choose calculus then integral. With the cursor between 
the parentheses, go to Variables and choose the acceleration axis you wish to use (there 
may be up to three different axes recorded). 
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6. Click on Options to select the color of the graph trace that will be used for your 
calculated values. 

7. Either create a new graph, or use the graph that already exists. (A new page can be 
created and the results of your analysis can be displayed there.) For the vertical axis, 
choose “More…” then select the new column from the data series that you selected. Click 
the Autoscale button to make this data display over the whole size of the graph. 

 
Note: This document advocates calibrating a vertically oriented accelerometer so it registers 
+9.8 N/kg or +1 g when there is no net acceleration occurring in the vertical direction. This is 
commensurate with the constant upward normal force experienced as a reaction to gravity. The 
net acceleration is zero (0). To get the net acceleration in any vertical situation, simply subtract 
9.8 N/kg or 1 g from the instantaneous value. During free fall, then, the recorded value of zero 
would be converted into a net value of –9.8 N/kg or –1 g. If you are creating a “Change in 
Velocity” graph for free fall, this additional correction must be added to the Equation. And of 
course you would be working with the m/s2 equivalent of N/kg. 
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